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Chapter 

1 Introduction to the 4059 Attendant
console

1.1 Introduction
The 4059 IP also called SBC (Screen Based Console), is integrated into the OmniPCX Enterprise. This
application provides the maximum level of comfort and user friendliness. It is used when there is just a
single attendant set for a system. It may also form part of a team of attendants when telephone
requirements mean that several dedicated sets are necessary.

The Alcatel-Lucent 4059 IP can be set up in one of the two configurations:

• an IP configuration using the IP network, where the terminal is referred to as Alcatel-Lucent 4059 IP
and the attendant set is an Alcatel-Lucent 8 series set.

• a mixed IP configuration using the TDM and IP network, where the terminal is referred to as Alcatel-
Lucent 4059 IP and the attendant set is an Alcatel-Lucent 9 series set.

The Alcatel-Lucent 4059 IP is used to optimize call management: to reply to and easily direct incoming
calls, to manage internal calls and, if necessary, to connect internal sets to recipients outside the
system.

This console also allows the attendant to take some responsibility for system management. The
following operations, among others, are available to the attendant:

• Switching over the system from standard operation to a status configured for reduced activity (at
night, for example)

• Reserving external lines for a specific use
• Controlling the use of internal and external lines by the users
• Selecting automatic connection of calls
• Programming the date and time of the system, the checking of call costs, etc.

You are advised to read this user manual before using the console.

1.2 System Architecture
All attendants must be part of an attendant group, consisting of up to 50 attendant sets/consoles (the
maximum number of attendants in an attendant group depends on the product software version).

The attendants within a group can use different sets/consoles, but all the terminals of the group must
be on the same node and the same IP network. An attendant terminal can only belong to one group.

The 4059 IP application runs on a PC with one of the following operating systems:

• Microsoft Windows XP Professional SP3 (minimum)
• Windows 7 (as of release 5.2.3)
• Windows 8 Professional Edition (32 or 64-bits Editions) (as of release 5.4.1)
• Windows 8.1 Professional Edition (32 or 64-bits Editions) (as of release 5.4.1)
• Windows 10 (as of release 5.5.x)

The 4059 IP application environment includes a software, a specific keyboard, and an Alcatel-Lucent 8
series or Alcatel-Lucent 9 series set.
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Figure 1.1: 4059 IP Attendant Console (IP or Mixed IP Configuration)

1.3 The 4059 IP Keyboard
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The USB Telephonic keyboard has specific keys for call handling and other telephone functions. With
an IP or a mixed IP configuration, the loudspeaker is replaced by a cover as the audio features are
provided by the Alcatel-Lucent 8 series or Alcatel-Lucent 9 series set.

On this keyboard, all keys which are not identical to those on a standard PC keyboard are used by the
4059 application. These keys are used for immediate call handling, even when using another
application or when the application and/or the PC are off.

A LED is associated with each keyboard key dedicated to call handling. A lit LED informs the attendant
that the corresponding key is available for any operation.

Certain standard PC keys can also be used for call handling.

1.3.1 Switchover Key
This key is also called the application switchover key. When the 4059 application started
on the PC, the key is used to switch from the 4059 window to another PC application
(and vice versa).

Note:
Ensure that in the display configuration, the 4059 activation option: By Application switch key is
selected (see Window appearance and display on page 50)

1.3.2 Call Handling Keys
Opens the personal directory of the console (to configure it, see Programming the individ-
ual directory on page 51)

Release: ends the attendant intervention on a call.

Answer an internal call.

Redial a number from the list of the last 10 outgoing calls.

Broker call.

Place on hold/transfer: places a call on hold (or transfers a call).

Cancel the consultation call: returns to the main call.

Call: calls the selected set.

Answer an external call: displays the list of incoming calls.
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External trunk: displays the list of calls routed or placed on hold.

1.3.3 Audio Keys
Note:
For IP or mixed IP configurations, the following keys activate/deactivate the audio functions on the associated
Alcatel-Lucent 8 series or Alcatel-Lucent 9 series set.

Activate/deactivate the hands-free function

Mute

Activate/deactivate the loudspeaker

Lower the volume

Raise the volume

1.3.4 Specific LEDs
Six specific LEDs provide information on the system status.

Night forwarding

Trunk reservation Mail System message

Auto answer Auto transfer

Note:
The System message LED light is not on even if the attendant receives a message.

1.3.5 Standard Keys Used for Call Handling
These keys are located on the numeric keypad of the keyboard.

0 to 9 To dial a number

# To indicate the end of dialing

- To seize a trunk on the same trunk group without having to dial

1.4 Attendant Set Characteristics in IP or Mixed IP Configurations
All the audio features of the 4059 IP attendant are provided by the Alcatel-Lucent 8 series or Alcatel-
Lucent 9 series set. Audio keys and icons are disabled on the set. The USB Telephonic keyboard audio
keys or corresponding 4059 application audio menu are used instead.
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1.4.1 Set Types
The 4059 IP attendant set can be one the following types:

• in IP configurations: Alcatel-Lucent IP Touch 4008 Phone,Alcatel-Lucent IP Touch 4018 Phone,
Alcatel-Lucent IP Touch 4028 Phone, Alcatel-Lucent IP Touch 4038 Phone, or Alcatel-Lucent IP
Touch 4068 Phone

• in mixed IP configurations: 4009, Alcatel-Lucent 4019 Digital Phone, Alcatel-Lucent 4029
Digital Phone, or Alcatel-Lucent 4039 Digital Phone

1.4.2 Set Audio Devices

1.4.2.1 Audio Devices

The following device can be used on the associated set:

• Corded Handset
• Corded Handset AND Jack Headset
• Bluetooth Handset (with associated Alcatel-Lucent IP Touch 4068 Phone only)
• Handset AND Bluetooth headset (with associated Alcatel-Lucent IP Touch 4068 Phone only)

Note:
The bounding sequence is not available when the set is associated to 4059 IP. There is no display/information on
the bounded devices on the 4059 IP attendant application.

1.4.2.2 Icons

• There is no handset icon.
• When a headset is detected by the set, the associated set displays a headset icon (there is no

headset icon on the PC).

1.4.3 Selection between Handset and Headset Mode
When the headset is in service, the attendant is automatically in Headset mode.

Possible audio modes are:

heaset, headset and loudspeaker, hands-free, mute or not.

When the headset is out of service, the attendant is automatically in Handset mode.

Possible audio modes are:

handset, Group listening, hands-free, mute or not.

1.4.4 Bluetooth Bonding Sequence
The bounding sequence is only possible when the 4059 IP is in plugged-out state.

There is no display or information about the bound devices on the 4059 IP attendant application.
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1.4.5 Bluetooth Call Recovery Sequence

Figure 1.2: Bluetooth Handset:

Figure 1.3: Bluetooth Headset

Caution:
The associated sets will take a few seconds (about 20 seconds, Alcatel-Lucent IP Touch 4068 Phone
characteristics) before it detects the loss or retrieval of the Bluetooth link.

1.4.6 Audio Device Keys
The keys on the Bluetooth handset have no effect. The On/Off key on the handset can switch on/off the
handset.

The keys on the Bluetooth headset have no effect. The On/Off key on the headset can switch on/off the
headset.

The key located on the Jack headset has no effect on the attendant.

1.4.7 Set Incompatible Features
The 4059 IP attendant set cannot support the following features:

• Multiline (for example: boss-secretary, twin set, supervisor)
• ACD
• Hotel (except administrative set)
• Pickup group or hunt group
• Alarm set
• 4980 application software
• Subdevice S0 or Z
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1.5 The Call Window

Note:

There may sometimes be differences in the display and the terms used:

• Depending on the country the system is in, the application may designate certain functions using a different
name.

• Depending on the configuration carried out by the system administrator, this display may show calls on hold in
a Routing calls frame.

1.5.1 On-line Help
The Help menu in this window allows you to access:

• This user manual
• Help on interactions between the 4059 application and Assisted Telephony
• A reminder on the meaning of the USB Telephonic keyboard keys
• An About window giving the 4059 version used and the identity of the attendant

1.5.2 Title and Menu Bars
The standard Windows title bar is located at the top of the window. It gives the name of the application
and the name of the authorized user: Alcatel-Lucent 4059 IP (“attendant login”) .
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The menu bar is found directly below the title bar. It is used to access the different functions of the
application. For example:

1.5.3 Information Display Field
The display field occupies the top part of the window. It contains two fields: the first is Busy lamp field,
the second is Programmable keys.

The windows of these fields may be re-sized and re-positioned in order to better organize the screen
(see the Window appearance and display on page 50).

The color of the individual title bar for these two fields indicates whether they are active.

You can pass from one sub-window to the other using the mouse or using the Tab key on the
keyboard.

Within a single field, if there are too many icons or programmable keys to be displayed, several pages
are created. You can use the Page Up or Page Down keys to move between pages.

1.5.3.1 Busy Lamp Field

To configure the supervision icons in the busy lamp field, see the Supervision icons on page 56.

The supervision icons indicate the status of sets, trunks, and trunk groups. A maximum of eight
supervision icons can be displayed on a single console. To display more icons, install the 4059 BLF
application.

Double-click on an icon to activate it. To find out the function and status of an icon (and display a help
field), point the cursor at the icon.

Equipment which is not configured in the Alcatel-Lucent OmniPCX (or located on a different OmniPCX

node to the attendant console) is represented by the icon . The meaning of the other icons is given
below.

The attendant console only supervises the equipment located on the same node as itself.

1.5.3.1.1 Digital Sets

Set free (icon green)

Set out of service (icon red)

Set inaccessible (icon yellow)

Set positioned to Do Not Disturb (icon gray)

Set busy (internal party)
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Set busy (external party)

Set busy without conversation (icon yellow)

Set absent (having left an absence (apology) message)

1.5.3.1.2 Analog Sets

Set free (icon green)

Set out of service (icon red)

Set inaccessible (icon yellow)

Set positioned to Do Not Disturb (icon gray)

Set busy (with an internal party)

Set busy (with an external party)

Set off-hook

Set absent (having left an absence (apology) message)

1.5.3.1.3 Attendant sets (and consoles)

Set free (icon green)

Set out of service (icon red)

Set busy

Set not connected

Attendant absent
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1.5.3.1.4 Fax

Available (icon green)

Busy (icon yellow)

Out of service (icon red)

1.5.3.1.5 Hunt Groups

A hunt group consists of two or more sets. These sets share the same directory number so that calls
can be answered by any one of them.

Hunt group free (icon green)

Hunt group busy (icon yellow)

Hunt group partly busy (icon green at front and yellow at back).

1.5.3.1.6 Trunks

A trunk is a telephone line between two systems. It connects two Alcatel-Lucent OmniPCX or an
Alcatel-Lucent OmniPCX and another PBX.

Trunk free (icon green)

Trunk busy (icon yellow)

Trunk placed out of service for Hardware or Software (icon red).

1.5.3.1.7 Trunk Groups

A trunk group is a group of trunks of the same type, all configured identically.

Trunk group free (icon green)

Trunk group busy (icon yellow)

Trunk group partly busy (icon green at top and yellow at bottom)

Trunk group out of service for Hardware or Software (icon red)

1.5.3.2 Programmable Keys

Point the cursor to a programmable key to display help for this function. The status of the key is
indicated by a LED (green=active). These keys are programmed by the system administrator or by the
attendant (see the Programmable Keys on page 43).

To select a function, double-click on the key or press the key directly on the USB keyboard (F1 to F8)
which corresponds to the function required.

If there are more than eight functions programmed, use the Page Up or Page Down keys on the
keyboard to display the other programmable keys.
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Note:
For each new page, although the keys displayed present different functions, their order corresponds to the keys F1
to F8 on the keyboard.

1.5.4 Status Bar
This display field, which is located directly above the call handling field, is divided into several parts:

• Call waiting counters
• Status icons
• Dialing area

1.5.4.1 Call Counters

This field indicates the number of incoming calls. Each call is represented by a colored rectangle:

• Red: urgent calls on hold (Urgent)
• Yellow: average calls on hold (Medium)
• Green: incoming calls on hold (Normal)

Example: 

1.5.4.2 Status Icons

The status of the attendant set is indicated by a row of icons in the status bar.

Example: 

If the icon is grayed out, the corresponding function is not active.

Each icon has a specific meaning:

In use/activated

Attendant absent. When a console is not used and the attendant has not replied to
calls for a certain amount of time, the console automatically changes to absent
mode.

Day service

Night service

Status of the supervision icons (activated or deactivated)

Hands-free mode

Mute deactivated - micro activated

Loudspeaker
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Automatic answer

Automatic transfer

Loudspeaker volume

Rotary dialing (deactivated)

Service mode

Guide mode

1.5.4.3 Dialing Area

The dialing area only appears (in place of the status icons) for the time it takes to dial the number.

1.5.5 Call Handling Fields

1.5.5.1 Console Idle

When idle, the fields displayed are:

• The field identifying the calls to be handled
• The field for routing calls or on hold calls
• The call waiting counters (see Call Counters on page 18)
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1.5.5.1.1 Incoming Calls (Next Calls)

The following information is displayed for each caller:

• Caller identity (surname-first name)
• Directory number
• Entity
• If the caller is a VIP guest

Note:

The system administrator can configure a different display and unique ringing tone for calls from VIP guests.

The VIP feature is special to hotels and hospitals.

Additional information appears when the attendant takes the call.

1.5.5.1.2 On Hold Calls

The following information is displayed for each caller:

• Caller identity (last name-first name)
• Directory number
• Entity

1.5.5.2 Active Console

The active window of the Alcatel-Lucent 4059 offers a user-friendly display of the calls in progress.

Note:
The console is active when a call is sent or received by the attendant.

On the active console, the Next calls and Routing calls fields detail:

• The main call
• The call on hold (information on a consultation call)
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1.5.5.2.1 Main Call

This field displays:

• An icon corresponding to the call status
• The caller's last name and first name
• Entity
• If the caller is a VIP guest
• The status of the calling set
• Directory number
• Telephone facilities class of service (category)

Note:
The icon displays the status of the user set. The information displayed changes according to the call handling.

Meaning of the icons showing the status of the set to be called:

Idle (on-hook)

Set rung

Set placed on hold (or transfer)

Set busy or in conversation

Wrong number (or set out of service, or access prohibited)

1.5.5.2.2 On Hold Call

This field displays information concerning an internal or external consultation call initiated by the
attendant (to transfer the main call, for example).

It gives the name, the directory number called, the class of service for the connection (to the public
network) of the set, the nature of the call and the entity to which the set belongs.

Note:
The information field for the call in progress is in color; the field for the main caller is grayed out.
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1.5.6 Function Keys
There are six function keys available to the attendant. These functions, relating to call handling, are
only carried out using the keys numbered S1 to S6 (on the window or on the USB keyboard).

S1 S2 S3 S4 S5 S6

The functions associated with keys S1 to S6 depend on the status of the call in progress.

The  and  keys on the keyboard correspond to the  and  keys on the screen. They are
used to move from one page to another if more than six functions are programmed.

1.5.7 Date and Time
This field, located at the bottom of the 4059 window, gives the PC date and time.

Note:
The attendant can change the date and time on their PC. They must have authorization from the system
administrator to modify them on the OmniPCX Enterprise. If there is a difference between the time on the PC and
the time on the Alcatel-Lucent OmniPCX, when starting the application, a dialog box prompts the attendant to
contact the system administrator to rectify the problem.
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Chapter 

2 IP Attendant activation/deactivation

The IP attendant features are activated only when all of the following actions are completed:

• the PC is connected to the TCP/IP network
• the 4059 IP application is running
• the attendant is activated (refer to module Alcatel-Lucent 4059 attendant console - Introduction to

the 4059 Attendant console / Call window)

Once the IP Attendant features are activated, the associated Alcatel-Lucent 8 series or Alcatel-Lucent
9 series set is dedicated to the attendant audio features and cannot be used as a standard set. Any call
to this set is forwarded to the attendant.

When the IP Attendant features are not activated, the Alcatel-Lucent 8 series or Alcatel-Lucent 9 series
set can be used as a non-attendant dedicated set and no attendant features are available. Refer to
module Alcatel-Lucent 4059 attendant console / Introduction to the 4059 Attendant console / Attendant
set in IP or mixed IP configurations for the incompatible set features.

Interactions with other features are detailed in the following table:

Feature IP attendant activated IP attendant deactivated

Message All signalization about mail is
disabled on the set (the LED is
off)

All message features that are
standard on the set are provided

The set retrieves mail signaliza-
tion and features

Forward Associated Alcatel-Lucent 8 ser-
ies / Alcatel-Lucent 9 series set
is immediately forwarded:

Attendant checked-in, all the
calls to Alcatel-Lucent 8 series /
Alcatel-Lucent 9 series set reach
the attendant.

A set XXX is immediately forwar-
ded to the associated Alcatel-Lu-
cent 8 series / Alcatel-Lucent 9
series set:

Attendant checked-in, all the
calls to the XXX set reach the at-
tendant.

Associated Alcatel-Lucent 8 ser-
ies / Alcatel-Lucent 9 series set
is immediately forwarded:

Attendant checked-out, all the
calls to Alcatel-Lucent 8 series /
Alcatel-Lucent 9 series follow
the forward.

A set XXX is immediately forwar-
ded to the associated Alcatel-Lu-
cent 8 series / Alcatel-Lucent 9
series set:

Attendant checked-out, all the
calls to the XXX set reach the
associated Alcatel-Lucent 8 ser-
ies / Alcatel-Lucent 9 series set.

Overflow Same as Forward Same as Forward

DND Same as Forward Same as Forward

Call back • The set is protected against
call back

• The set cannot request a call
back

The set is protected against call
back
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Feature IP attendant activated IP attendant deactivated

PRS Same as out of service set (if the attendant is plugged-in)

Wakeup When the attendant is unplugged, a wake up can be set on the as-
sociated set, an icon is displayed on the set when the wake up is

programmed.

When the attendant is plugged-in with a wake-up to come, the
wake-up icon is erased.

When the attendant is unplugged again, with a wake-up to come,
the wake-up icon is displayed again.

When the wake-up occurs, there is a first try.

If the attendant is unplugged, the wake-up can occur.

If the attendant is plugged-in, the set is out of service, the wake-up
cannot occur and there will be a second try (the last one) 2 minutes

later.

Wake-up second try:

If the attendant is unplugged, the wake-up can occur.

If the second try fails, an incident is generated. This incident re-
ports the wake-up cannot take place. This is the common working

way of wakes-up.

Night forward The associated Alcatel-Lucent 8 series / Alcatel-Lucent 9 series set
can be a night forward set

If the attendant is plugged-in, the calls to the night forward set are
diverted to the attendant.

CDT The set can be a distribution table

Prefix Cannot be dialed on the set as
the set keyboard is disabled

Can be dialed

Substitution • total substitution is not possible on Alcatel-Lucent 8 series /
Alcatel-Lucent 9 series set

• partial substitution is possible

2.1 Modifying the 4059 IP Attendant
If the 4059 IP Attendant is in plug-in state

• It is forbidden to modify the Associated Set
• It is forbidden to modify the Terminal Ethernet Address

2.2 Deleting the 4059 IP Attendant
• The 4059 IP Attendant must be unplugged (with Alcatel-Lucent 8 series / Alcatel-Lucent 9 series

set).
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• Delete the 4059 IP Attendant termination (the Alcatel-Lucent 8 series / Alcatel-Lucent 9 series set is
no longer associated with the 4059 IP).

2.3 Viewing the Associated Alcatel-Lucent 8 series / Alcatel-Lucent 9
series set

You can view the QMCDU of the 4059 IP in the data of the associated Alcatel-Lucent 8 series / Alcatel-
Lucent 9 series set but you cannot modify it.

2.4 Modifying the Associated Alcatel-Lucent 8 series / Alcatel-Lucent 9
series Set

It is forbidden to modify the Terminal Ethernet Address if the 4059 IP attendant is plugged-in.

Every modification must follow restrictions.

2.5 Deleting the Associated Alcatel-Lucent 8 series / Alcatel-Lucent 9
series Set

• The 4059 IP attendant must be unplugged (with Alcatel-Lucent 8 series / Alcatel-Lucent 9 series
set).

• Dissociate the Alcatel-Lucent 8 series / Alcatel-Lucent 9 series set from the 4059 IP (in the Operator
configuration).

• Delete the Alcatel-Lucent 8 series / Alcatel-Lucent 9 series set termination.
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3 Attendant console operation

3.1 Opening a Session
When the PC has been started up, you can either:

• Double-click on the Alcatel-Lucent 4059 icon on the desktop
• Click on Start > Programs > Alcatel-Lucent 4059.

3.2 Implementing the Console (Status)
When the console is first powered on, it initializes in inactive mode (unplugged position). This is

indicated on the screen by the  icon (grayed out) in the status bar.

To bring the console into operation, select the Sign on option in the Attendant menu. The console

becomes active, as shown by the change in color of the  icon.

Note:
For a full description of the icons in the status bar, see the Status Bar on page 18.

To use the USB keyboard and its specific keys, press the  key. The red LED of the key should be
lit.

Note:
For a full description of the specific keys on the keyboard, see the The 4059 IP Keyboard on page 9.

3.3 Methods for Calling a Number

3.3.1 Direct Dialing
Dial the number directly on the numeric keypad of the keyboard.

To reach an external number, first dial the external line seize prefix, then the external number.

To set up the call: once the number has been dialed, press the  key.

3.3.2 Call Using the Set Directory
The personal directory (which can be programmed from the 4059 console, see the Programming the
individual directory on page 51) is used to select a user directly via a key, without having to dial their
number on the keyboard.

Note:
The number called may be an internal, external, or speed dialing number.

Calls using the personal directory can be made with the attendant set in the idle state or being used for
a consultation call.

To access the directory, press the  key.
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Select the name to be called and click on Redial. Press the  key.

3.3.3 Call Using Programmed Key
When a key is programmed with a directory number, click on this key (or press the corresponding F key

on the keyboard, then the  key).

Note:
These keys (see the Programmable Keys on page 17) are either programmed by the system administrator or
programmed from the console (see the Programmable keys on page 55).

3.3.4 Dial by Name
This feature allows you to call an internal (or external) user without having to dial their directory
number. Dial by name can be requested either from the idle state or during a consultation call.

When a dial by name request is made, the system carries out an internal search in the available
directories. These directories can be the personal directory for the set, the system directory, or a
standardized LDAP or ODBC directory. They are managed by the system administrator. To determine
which directories are used to dial by name, see the Selecting directories to use for the dial by name
option on page 52.

3.3.4.1 Call Via the Keyboard

1. On the keyboard, type the first two letters of the name to be called.

Note:
Pressing any key on the alphabetical keyboard switches the console to Dial by name mode.

2. Enter the following letter(s).
3. The application searches for a match in all the directories selected for the search by name (see 

Selecting directories to use for the dial by name option on page 52).

4. If the result does not correspond to the name required, enter one or more additional letters.
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5. If several names appear, select the required name.

6. Click on  to dial the selected number. This closes the directory search window.

To close the search window without dialing a number, click on .

7. To start dialing, press the  key.

3.3.4.2 Dial by Name Using the Directories

This option is used to search by last name, by last name + first name, or by initials.

The Directory menu contains the Multi-Directory Search option, as well as a configured directory
option.

1. Select the required option in the Directory menu.

2. For a search by initials, enter the initials of the last name and first name, then click on Initials S3 or
press the S3 key on the keyboard.

For a search by last name, enter the first letters of the last name, then click Name S2 or press the
S2 key on the keyboard.

For a search by last name and first name, enter the first letters of the last name and the first name,
then click First Name S4 or press the S4 key on the keyboard.

To move from one field to another, use the mouse or the Tab key on the keyboard.
3. If several names appear, select the required name. If the required name does not appear, enter one

or more additional letters. The vertical arrows of the keyboard can be used to select one of the
names displayed. The right (horizontal) arrow can be used to display additional details concerning a
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party (as entered in the LDAP and ODBC directories). Click on the heading to each column to sort
the users by alphabetical order or by phone number.

4. Click on  (or press Enter on the keyboard) to dial the selected number. This closes the directory
search window.

To close the search window without dialing a number, click on .

5. To start dialing, press the  key.

3.3.5 Call by Speed Dialing
To dial an abbreviated number, you can either:

• Dial the direct call prefix
• Dial the access prefix followed by the row of the abbreviated number

Speed dialing is most often used for external dialing only. Once the dialed number has been analyzed
by the system, the procedure is then the same as for an ordinary call.

3.4 Call to an Internal User
To call an internal user:

1. Dial the set number. The status of this set (free, busy, other) is shown in the call handling field (see
the Active Console on page 20).

2. If the set is free (on-hook), press the  key.

Depending on the status of the set, the function keys are used to send a specific message or to run
another function on the called set (see the Function Keys on page 22).

3. To end the call, press the  key.

3.4.1 Reserving (locking) an Internal User Set (Attendant Control)
When an internal user number is dialed, the user set, if free, is reserved by the attendant. The user can
no longer dial a number or access another service.

This attendant control is indicated on the user set:

• By the  symbol on the resource keys (multiline set)
• By the deletion of any entry on the screen

The user set does not ring until the attendant presses the  key.

This special console feature allows the called user to be reached at all times. If the user picks up the
receiver, they hear the hold music (or the corresponding tone), indicating that the set is reserved and
that all outgoing calls are denied.

3.4.2 The Called Set is Free
The call handling field displays:
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• The  key rings the set.

• The  key releases the call.
• The Call Back function key sends a call back request to the called set (see Sending a Call Back

Request on page 31).
• The Text Mail function key is used to send a text message to the called set (see Text Messaging on

page 40).

3.4.3 The Called Set is Busy

3.4.3.1 The Set Is Multiline

If the user set is a multiline set, it is not locked and can make calls. However, a set resource is used for
the incoming call from the attendant set.

The call handling field displays:

The attendant can use:

• The  key to ring the set.

• The  key to release the call.

The procedure to be followed after this screen is the same as the procedure described for calling a free
set.

3.4.3.2 The Set Is a Single Line Set

The call handling field displays:
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The attendant can use:

• The  key to release the call.
• The Break In function key to barge in to a conversation in progress (see Barge-In on page 36)
• The Call Back function key to activate a call back request (see Sending a Call Back Request on

page 31).
• The Display Mail function key to display a message on the user set
• The Text Mail function key to leave a text message (see Text Messaging on page 40)

3.4.3.3 Sending a Call Back Request

When a set is busy, the attendant console can send a call back message by clicking on the Call Back
function key. The user is notified of the arrival of a message during the call (LED flashing).

By reading this message, the user can activate the call back to the attendant. This call is handled like a
standard incoming call.

3.4.4 Special Cases: Sets Forwarding or Cannot Be Reached
The call handling field gives the status of the called set.

If this set cannot be reached, is out of service, or is not authorized, press the  key to release the
call.

3.4.4.1 The User Is Absent (Apology Message)

When a user can leave an absent (apology) message because he or she cannot answer, the attendant
can read the message when the user is selected.

To call the set despite the user request, press the  key.

3.4.4.2 The Set Is Forwarding to Another Set

3.4.4.2.1 The Set Is in Immediate Forwarding Mode

The call handling field shows the forwarding destination and the entity to which it belongs, then the set
called (set initiating the forward) and its number. It also gives the status of the set to which the called
set is forwarded:
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The attendant can use:

• The  key to ring the set (forwarding destination).

• The  key to release the call.
• The Override function key, to override the forward and call the initial set
• The Call Back function key to activate a call back request
• The Text Mail function key to leave a text message

3.4.4.2.2 The Set Is Forwarding on No Answer

The call handling field shows the set called (set initiating the forward), then the forwarding destination
and its number. It also gives the status of the set to which the called set is forwarded:

The attendant can use:

• The  key to ring the set.

• The  key to release the call.
• The Forward function key to reserve the forwarding destination

Note:
The attendant can then either ring the forwarding destination or use the Override (to return to the initial
destination) or Text Mail (to send a text message to the forwarding destination) function keys.

• The Call Back function key to activate a call back request
• The Text Mail function key to leave a text message

3.5 External Calls
Dial the trunk group seize prefix: the call handling field displays the name of the trunk group. Then dial
the number of the external party.

Once the length of the number is recognized by the system, the trunk is reserved.

Use:
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• The 
Del

 key to send the dialing (when the length of the number is not recognized by the system).

• The  key to release the call and seize the same trunk again (to make another external call).

• The  key to release the call.

3.6 Answering Calls
When a call is presented on the console, it is indicated by:

• A ringing (depending on the system configuration)

• The lighting of the LEDs on the  and/or  line seize keys
• The appearance of an icon in the call counters (see the Call Counters on page 18)

The call handling field gives information on the nature (or even the party) for this call (see the Call
Handling Fields on page 19).

To answer a call when it arrives, press the  key.

To release the call, press the  key.

3.6.1 Selecting the Answer Type: Automatic or Manual
This operating mode is used to automatically connect the console to any incoming call or call on hold.

1. In the Extension menu, select the Guide mode option, or press F11 on the keyboard.
2. Double-click on Auto answer, or click on Auto answer and then press Enter on the keyboard.

3. Select Enable to activate automatic answering of incoming calls by the console.

Select Disable to manually answer calls.
4. Select Apply to save the changes.
5. Click on Close to close the window.
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3.6.2 Choosing which Call to Answer First
All incoming calls are displayed in the call handling field. When several calls are presented, it is
possible to select a specific call to answer first.

The call can be selected from any of the lists given in the call handling fields.

If the list cannot be seen on the screen, do one of the following:

• Press Shift and the  key simultaneously to display the list of incoming calls.

• Press Shift and the  key simultaneously to display the list of calls on hold.

Note:
The list of calls on hold is displayed according to the system configuration.

By default, the first call is selected. If necessary, use the Page Up and Page Down keys to display the
call to be answered as a priority.

To answer this call, double-click on it or use the keyboard as follows:

1. Select the call.
2. Press Enter, or press the key corresponding to the number of the call in the list.

3.6.3 Answering an Internal Call
Proceed as in Answering Calls on page 33.

If a call is for the attention of an attendant group (when several attendants handle calls on the same

system), the  key lights up.

To answer this call, do one of the following:

• Press the  key (which allows you to answer group calls as a priority).

• Press the  key.

3.6.4 Answering an External Call
Proceed as in Answering Calls on page 33.

3.6.5 The Attendant Does not Answer Immediately
If the attendant does not answer immediately, the call changes to medium, then to urgent (see the Call
Counters on page 18).

The console signals this urgent call on hold by:
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• A ringing on the attendant console

• Lighting up the LED of the  line seize key
• Displaying Call on Hold in the next calls field
• Increasing the value on the counter

If the attendant still does not answer, they are considered by the system to be absent. The  icon is

replaced by the  icon on the status bar.

Incoming calls are then handled as if the console were in night mode.

To bring the console back into service, proceed as in Implementing the Console (Status) on page 26.

3.7 Holding a Call

Use the  key to place a call on hold. The call counter is automatically increased. The user hears
the hold music or the corresponding tone.

If the attendant console is not in conversation and the call is not taken before the end of the timer,
ringing is activated to indicate that the call is returned. The call waiting counter changes to Urgent.

To return to the first call placed on hold, press the  key.

To return to another call placed on hold, proceed as in Choosing which Call to Answer First on page
34.

3.8 Redial Function: Redialing a Number
The Redial function is used to redial a previously dialed number.

1. In the Attendant menu, select the Redial option or press the  key.
2. In the list that displays, select one of the last ten called parties.
3. Double-click on the name or click on Redial to dial the number.

3.9 Consultation Call
The consultation call is activated when a console is already involved with a first call.

Dial a number using the numeric keypad on the keyboard or use another method (see Methods for
Calling a Number on page 26) to call a second party.

The first call is in conversation. The second call (if it is an internal call) is reserved (see Reserving
(locking) an Internal User Set (Attendant Control) on page 29).
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Use the following keys:

•  To call the second party

•  To cancel the consultation call and return to the main call

•  To transfer the main call to the second call

•  To release the call in progress and the reservation of the second party (if internal)

At the bottom of the screen, use the following keys:

Call Back To activate a call back request on the second party's set

Text Mail To leave a text message on the second party's set.

3.10 Broker Call
The broker call is used to move rapidly from one party to another during a consultation call.

1. Press the  key. The first party is placed on hold. The second is in conversation with the
console.

2. Press the  key again to place the second party on hold. The first party is in conversation with
the console.

This operation can be repeated as often as necessary.

3.11 Barge-In
Barge-in (or intrusion) allows the attendant to interrupt a conversation between two users.

After dialing, the console indicates that the user is busy.
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At the bottom of the screen, the  Break In function key is used to barge into a conversation. Press
this key, or the corresponding S key on the keyboard.

The  Break In key becomes  Break In. The two users are informed of the presence of the attendant
by a beep.

To end this barge-in, press the  Break In key or the corresponding S key on the keyboard.

3.12 Call Transfer (Routing)
The console is in conversation with a user (internal or external user). To transfer a call to a user, use
the consultation call function (see Consultation Call on page 35).

Note:
For an external call made by the attendant and transferred to an internal set, the charge units are charged to the
attendant console when it is the last set to be involved in the call (in the case of no answer to a transfer, for
example).

You can then either:

• Directly transfer the call (transfer without presentation)
• Orally present the call to the second user before the transfer (transfer with presentation)

3.12.1 Selecting the Transfer Type: Automatic or Manual
Automatic transfer is used to transfer a call to a free user immediately after the dialing by the user,
without the need for any further action.

1. In the Extension menu, select the Guide mode option, or press F11 on the keyboard.
2. Double-click on Auto transfer, or click on Auto transfer and then press Enter on the keyboard.
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3. Select Enable to activate the automatic transfer.

Select Disable to deactivate the automatic transfer.
4. Select Apply to save the changes.
5. Click on Close to close the window.

If the console is configured to automatically transfer calls, a specific call in progress can be transferred
manually:

1. In conversation with the first party, click  Auto Forward (or press the corresponding S key on the
keyboard).

2. Dial the number of the second party.
3. Trigger the dialing.

4. Present the call before pressing the  key.

3.12.2 Manual Transfer without Presentation

0298143322

Press the  key. The two parties are in conversation and the attendant console is released.

This type of transfer can be carried out on a free or a busy set. If the set receiving the transfer does not
take the call after a certain time, this call is directed back to the attendant console.

3.12.3 Transfer to a Call Put on Hold
As of OmniPCX Enterprise R11.0 and release 5.3.5 of the application, a call, whether outgoing or
incoming, can be transferred to a call put on hold by the attendant.
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When in conversation with a party, a Call on hold can be selected by the attendant.

If a call on hold is selected, all the operations detailed: Consultation Call on page 35 are available.

Press the  key to place the call back on hold.

Reminder:
In a standard consultation call, press this key to release the call.

This type of transfer is not available for camped-on, barged-in and reserved call on a set in the do not
disturb state.

3.13 Transfer to a Meet Me Conference
The attendant (who cannot take part in a programmed conference) can add a party if the conference
circuit is not saturated. The attendant can also reserve a conference circuit to add different parties (up
to 29) to this Meet Me conference (also called an N party conference).
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During these conference transfer operations, the attendant can no longer answer internal or external
calls. However, the normal and urgent call waiting counters are updated by incoming calls.

If an external party is alone in the conference, they are forwarded to the attendant console after a timer.
However, if another party joins the conference, this timer is canceled and the conference begins.

3.13.1 Adding the First Party
In conversation:

1. Click the MeetMeCf button (or press the corresponding S key on the keyboard).
2. Enter the code assigned to the conference. The first participant is connected. All the time this

participant is alone, the hold music or the corresponding tone is heard.

3.13.2 Adding other Participants
With the conference circuit still reserved, dial the number of the following participant in consultation call
mode and activate this call.

When the user answers, press the CfProg key to connect them to the conference.

Repeat this operation for the following participants.

3.13.3 Adding Participants into a Conference in Progress
To add other participants into a conference in progress, proceed as in Adding the First Party on page
40.

3.14 Text Messaging
The attendant console can send text messages to all authorized internal sets equipped with an
alphanumeric keyboard.

To send a text message:

1. Dial the internal set number. The set is reserved (see Reserving (locking) an Internal User Set
(Attendant Control) on page 29).

2. Press the Text Mail function key (or press the corresponding S key on the keyboard).

3. In the Type field, select System messages to send a pre-recorded message from the Alcatel-
Lucent OmniPCX, or select Attendant text-messages to send a message programmed on the
console (see the Creating text messages in advance on page 54).

4. Select the message to be sent, or complete the message of your choice using the keyboard. To
send a message other than a pre-programmed one, enter the message directly in place of the
displayed message.
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Note:
The message should not exceed 127 characters.

5. Click on Send.
6. The Receive status field indicates whether the message has been sent correctly.
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4 Additional features

4.1 Overview
This chapter details:

• The additional functions offered on the S keys (from the window and the USB keyboard)
• The operation of the keys pre-programmed by the system administrator

4.2 S Keys
During call handling, additional functions (presented on the S keys) can be used for the following
operations:

Note:

The  keys are used to change page.

4.2.1 Chained Call
Routing with chained release.

Routing with chained release allows the attendant to transfer an external call to an internal set. The
external party is rerouted to the attendant set as soon as the internal user has on-hooked.

The same call can therefore be routed to several sets in succession.

4.2.2 Charged Call
Routing with charged release.

During the routing of an external outgoing call to an internal user, the charged release activates the call
back to the attendant set when the internal set on-hooks. Answering the call back displays the identity
of the set and the number of charge units charged to this set.

4.2.3 Release Ctrl
Routing with release control.

During the routing of an external call to a busy internal set, the attendant can put the call on hold with
release control. When the internal user on-hooks, their set is not rung, but the external call returns to
the attendant set. The attendant can then route it to the called user.

4.2.4 Frwrd Attnd
Forwarding between attendants.

The attendant can forward an internal or external call to another attendant (or attendant group) whose
set is in service and available. The attendant can thus successively route the same call to several user
sets.

4.2.5 DTMF
Voice frequency/DTMF.
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Also called transparent dialing, or overdialing (DTMF), this function is used to resend additional dialing
to the same party on the line.

4.2.6 Record
Records the current conversation.

To end recording, press the  Record key again.

4.2.7 Rotary
Sends decimal rotary dialing to send a number to the current party.

4.2.8 Flash
Sends a calibrated pulse, also called cut-off or flashing.

This operation is used to activate a service for the recipient of a call (to another PCX or any other flash-
compatible communication system). This is used to:

• Send additional numbers
• Call back a service (a remote attendant, for example)

4.2.9 Auto Forward
Deletes automatic transfer for a specific call (see the Selecting the Transfer Type: Automatic or Manual
on page 37).

4.2.10 Malicious
Malicious call (not available in the USA).

Indicates a malicious call, to the system administrator for an internal call, or to the telephone operator
for external calls.

Note:
For external calls to be indicated as malicious, you must have a subscription for this service with the telephone
operator.

4.3 Programmable Keys
The programmable keys can be programmed by the attendant (see the Programmable keys on page
55). These keys can also be pre-programmed by the system administrator.

Note:
All keys presented here do not necessarily appear on a console. Contact the system administrator for an additional
configuration or further information.

To find out the function of the pre-programmed keys, right-click in the Programmable keys window (see
the Programmable Keys on page 17).

This dialog box is used to select a key from the list of programmable keys, to program the associated
type of element, and to give comments.

Example:
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4.3.1 Call Presentation
This feature is used to assign the waiting queue operating mode. One or more traffic flows can be
associated with one or more keys. By pressing a key, the attendant takes the waiting call with the
highest priority from the traffic flow(s) served by the key.

Several presentation keys can be configured by the system administrator to present only the following
calls:

• Non DDI entities (trunk group call all entities)
• Public entities (public DDI call all entities)
• Private entities (private DDI/internal call, all entities)
• Deb DDI entities (non answered DDI call all entities)
• Internal calls (private network)
• External calls (public network)
• VIP
• VIP2
• Call back (attendant)
• Transfer between attendants
• Other (misc.)
• General hold
• Chained call
• Charged release
• Individual call

Key 1 is pre-programmed by default as a call presentation (Miscellaneous) key. This cannot be
modified. This allows the attendant to take the call with the highest priority from those on hold resulting
from traffic flow(s) indicating an external party (external call, call back, return from chaining, etc.).
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4.3.2 Directory No Supervision
Press the key to lock the supervised internal set.

The attendant can configure a supervision icon (see the Busy Lamp Field on page 15) so that this icon
shows the status of the supervised set in real time (see the Supervision icons on page 56).

4.3.3 Speed Dialing Number
Press the key to call the corresponding number.

The attendant can also configure a key with a speed dialing number.

4.3.4 Individual Routing
Individual routing allows the attendant to route an external (supervised) call without placing it in the
queue.

4.3.5 Network/Network Transfer
This feature is used to inter-connect two external parties via the system, with the possibility of releasing
the connection.

Following an incoming call, the attendant makes an outgoing call to a party and is in conversation.
Pressing the key connects the two trunks and supervision is activated.

Pressing the key again allows the attendant to barge in. Pressing the key again exits the barge-in and
restarts supervision.

4.3.6 Trunk Group Supervision
This function allows the attendant to monitor the occupation level of a trunk group. If there are still
trunks free, pressing this key corresponds to an ordinary seizure without dialing of an external trunk
from this supervised trunk group.

The attendant can configure a supervision icon (see the Supervision icons on page 56) so that this
icon shows the status of the supervised trunk group in real time.

4.3.7 Out of Service Trunk Supervision
This feature warns the attendant of a trunk malfunction (no tone on seizure). When this key is pressed,
the display shows the number of the defective termination(s).

The termination can be isolated from the trunk group (see the Decommissioning a defective external
line on page 65).

The attendant can configure a supervision icon (see the Supervision icons on page 56) so that this
icon shows the status of the supervised trunk group in real time.

4.3.8 Individual Hold
Individual hold puts an external outgoing or incoming party on hold on a specific circuit. Pressing the
key connects the party to this individual circuit connected to the hold music.

Several keys can be programmed for individual hold, according to the size of the system.

The party can only be retrieved from the idle state. If the attendant console switches to idle mode, calls
on hold are redistributed after a timer.
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4.3.9 Transfer with Privilege
This feature lets the attendant transfer an external outgoing trunk to a user set if the corresponding
direct seize prefix is programmed on this key. The user will then dial the external party number as a call
in direct seize.
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Chapter 

5 Management from the attendant
console

5.1 Secret code of the set
The system administrator can use a secret code to authorize, prohibit, or control access to several
facilities (including bringing the set into service: see the Implementing the Console (Status) on page
26).

The secret code of the console can only be modified by the system administrator.

Certain functions are only accessible after entering the code for the console. The  icon indicates
the functions which require this code.

Once the attendant requests access to the facility which the administrator has set to Allowed with
Attendant Code, a window displays requesting the password.

A dialog box requests the input of the password. If it is correct, the function is automatically activated.

Inaccessible functions are indicated by the  icon.

5.2 Connection history
When the console of a PC is shared between several attendants, it may be helpful to check the history
of the latest connections.

In the Option menu, select Login history.

The window shows the PC username and the start and end dates and times of the connections to a
4059 console session.

Click on Close to close the window.

5.3 Customizing user interface
The console interface can be configured (and checked). In the Extension menu, select the Guide
mode option, or press F11 on the keyboard.

Example:
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All modifications described here are taken into account immediately. The application does not have to
be restarted.

5.3.1 Choice of Language
The system administrator chooses the languages available for the whole system. For the attendant to
have access to a particular language, their choice must be one of the languages programmed by the
administrator.

1. In the Extension menu, select the Guide mode option, or press F11 on the keyboard.
2. Double-click on Language, or click on Language and then press Enter on the keyboard.

3. Select the language to use.
4. Select Apply to save the changes.
5. Click on Close to close the window.

5.3.2 Ringing - melody - volume level
The call ringing melody on the associated Alcatel-Lucent 8 series or Alcatel-Lucent 9 series set can be
selected from 16 available melodies. Each melody has seven different volume levels.

1. In the Extension menu, select the Guide mode option, or press F11 on the keyboard.
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2. Click on Console, then double-click on Program Melody, or click on Program Melody and then press
Enter on the keyboard.

3. Select the melody to use.
4. Set the ringing level for the melody by moving the corresponding cursor.
5. To hear the reconfigured ringing, click on Test.
6. Select Apply to save the changes.
7. Click on Close to close the window.

5.3.3 Ringing - present or absent
By default, the ringing or on the associated Alcatel-Lucent 8 series or Alcatel-Lucent 9 series set is
programmed in normal mode: ringing starts on presentation of a call on the attendant set.

1. In the Extension menu, select the Guide mode option, or press F11 on the keyboard.
2. Click on Console, then double-click on Ringing type, or click on Ringing type and then press Enter

on the keyboard.

3. Select the ringing type to be used.
4. Select Apply to save the changes.
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5. Click on Close to close the window.

5.3.4 Window appearance and display
• In the View menu, select Configuration...

This dialog box offers the following options:

• Show or hide the programmable keys
• Show or hide the busy lamp fields (supervision icons)
• Define two sizes for the busy lamp fields when the programmable keys are not displayed
• Show or hide the individual call waiting counters
• Select the 4059 activation mode when the user is in another application
• Define the priority for call seizure when entity calls and other calls are received
• Modify the layout of the different windows on the screen when the Use full resizing options mode

is selected.

Click on OK to save the changes and close the window.

5.3.5 Displaying the date and time
1. In the View menu, select Status Bar.
2. If the date and time were already displayed, they disappear. If they were not already displayed, they

appear at the bottom of the window.

5.3.6 Background color
1. In the View menu, select Background color...

Chapter 5 Management from the attendant console

3EU19877ENBA  - Ed. 1  - October 2021 - Alcatel-Lucent 4059 IP Attendant Console 50/66



Custom colors:

Color

Basic color:

Define custom colors...

2. Select a basic color or click on Define custom colors.
3. Once you have chosen the color, click on OK.

5.4 Programming the individual directory
The attendant has an individual directory which can be configured, in addition to the system directory
and any external directories.

This directory can contain up to 3000 entries.

Note:
The individual directory is stored in the file Alcabc32/store.dat. If the console is uninstalled, it is deleted. Save it
before any new installation.

To access the console directory:

1. In the Attendant menu, select Store and Redial.
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2. Enter the last names, first names, and the number of the directory entry to be stored.
3. Click on Add.

To modify the last name (or the first name or the number) of a directory entry, double-click on it to
retype it using the keyboard.

Click on Delete to delete the selected name from the individual directory.

Click on Redial to dial the number of the selected user and close the window.

Click on Close to close the window without redialing a number.

5.5 Configuring the directories

5.5.1 Adding and configuring an external directory
One or more external directories (several ODBC directories and one LDAP directory) can be used by
the attendant console.

For more information on configuring external directories, contact the system administrator.

In the Options menu, select Directory, then Directory configuration:

This dialog box allows you to program the different directory configuration parameters:

• Add/Remove LDAP directory...: To add, modify or remove an LDAP type directory
• Add/Remove ODBC directory...: To add, modify or remove an ODBC type directory
• Search configuration...: To modify the existing LDAP and/or ODBC directory parameters

5.5.2 Selecting directories to use for the dial by name option
This option is used to define the directories used when searching via the keyboard (see the Call Via the
Keyboard on page 27).

In the Options menu, select Directory, then Dial by name:
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Click on Dial by name...:

Check the check boxes to include or remove the directory for a search by name.

OK Validates the selection

Cancel Cancels the selection and closes the dialog box

5.6 Appointment reminder
From the attendant console, appointment reminders can be programmed on system internal sets.

At the specified time, the internal set is rung and a voice guide informs the user that this is an
appointment reminder.

In the Extension menu, click on Appointment reminder:
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1. Enter the time in the format HH:mm.

The time format depends on computer configuration:

• If the computer uses format hh:mm:ss AM/PM, enter hh:mm AM/PM, e.g. 01:00 PM or
01:00:00 PM

• If the computer uses format hh:mm:ss, enter hh:mm, e.g. 13:00 or 13:00:00
2. Enter the telephone number of the internal set to be called.
3. Click on Add.

If no appointment is already programmed for this user, a dialog box confirms that the appointment
has been programmed. Otherwise, a dialog box indicates that an appointment is already
programmed.

To delete an appointment programmed on the console:

1. Uncheck the Appointment reminder box.
2. Enter the number of the internal set on which the appointment is to be deleted.
3. Click on Delete.
4. Click on Close to close the window.

5.7 Creating text messages in advance
The attendant can send text messages to internal users. A certain number of messages are stored by
default in the system.

To send a text message, see the Text Messaging on page 40.

To create specific messages in advance and send them with a single click:

1. In the Options menu, select Attendant text-messages.
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2. Enter up to 127 characters for a new message.

Click on Add... to add this message to the list.

Click on Delete to delete the selected message from the list.

Click on Close to save and close the window.

5.8 Assigning programmable keys and supervision icons

5.8.1 Programmable keys
The programmable keys (see the Programmable Keys on page 17) are programmed by the system
administrator (see the Programmable Keys on page 43) and/or by the attendant.

The keys programmed by the administrator cannot be modified from the console.

In the Option menu, click on Programmable keys (or place the cursor in the programmable keys
window, right-click, and select Configuration).

Example:
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To modify the content of a programmable key:

1. Select the programmable key: a box at the bottom of the window allows you to assign a call number
to it.

2. Enter the directory number to be dialed when this key is pressed.
3. Confirm the entry by clicking on OK.

If the system directory recognizes the number, the key displays the user's name.

To exit the menu, press Cancel.

5.8.2 Supervision icons
The supervision icons can be programmed from the 4059 console (the meaning of the icons is
described in the Busy Lamp Field on page 15).

In operation other than the BLF application, up to eight icons can be programmed from the console.

In the Option menu, click on Busy lamp field (or place the cursor in the busy lamp field window, right-
click, and select Configuration).

Example:
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To create or modify the content of a supervision icon:

1. Select the icon to be created/modified: the fields at the bottom of the window are used to configure
this icon.

2. Select the type of supervision (individual station, trunk line, trunk group). Free indicates that the icon
has not yet been configured.

3. In the next field, enter the number of the object to be supervised.

The third field (optional) is used to enter additional information. This information, if entered, displays
in place of the number entered in the second field.

4. For a new icon, click on Insert. Otherwise click on OK.

To delete an existing icon, select it from the list, then click on Delete.

To exit the menu, click on Cancel.

5.9 Reserving a trunk group
The attendant console can reserve one or more (analog) trunk groups so as to always have an outside
access.

In the Extension menu, select Service mode (or press the F10 key). Then double-click on Trunk
groups.
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This option authorizes:

• The reservation of one or more trunk groups by the console (to allow the attendant to call an outside
line when nearly all the available lines are being used by internal sets)

• The automatic reservation of a trunk group (if a trunk group is out of service, then brought back into
service, the reservation remains active)

• The direct seizing of a trunk group (which prohibits the seizing of trunk groups by internal users)

5.9.1 Reserving trunk groups
This window displays all trunk groups. Each trunk group in the list is described by:

• A reservation indicator (an icon if reserved, otherwise blank)
• The trunk group name
• An automatic reservation indicator (“yes” if the bundle can be auto reserved, otherwise blank)

When the user selects a trunk group, the name of the button changes according to the reservation
status of the trunk group:

• If the button says Free, the selected trunk group is reserved.
• If the button says Reserved, the selected trunk group is free.

To release or reserve a trunk group, the attendant must select the trunk group and press the Free or
Reserved button. The change is made automatically.

5.9.2 Trunk group auto reservation
This window is used to enable or disable the automatic reservation. If enabled, the attendant reserves
all system trunk groups that have been declared as automatically reservable.

Click on Apply.

5.9.3 Direct Seize
This window is used to authorize or refuse public network access for all sets on the system.

Click on Apply.
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5.10 Changing the status of the attendant group sets or the entity
The system administrator configures the call routings for the whole system in one of four states (night,
day, Forward1, Forward2).

The attendant console is used to change:

• The status of the attendant group to which it belongs
• The status of one or more entities in the system

In the Extension menu, select Service mode (or press the F10 key). Select Status programming.

5.10.1 Programming the attendant group status
In the Status programming option, select Group status.

1. Select one of the available options.
2. Click on Apply.
3. Click on Close to close the window.

5.10.2 Programming the entity status
In the Status programming option, select Entities status.
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1. Select the entity to be modified.
2. Select one of the available options.

Note:
The Normal option assigns the entity the same status as the attendant group.

3. Click on Apply.
4. Click on Close to close the window.

5.11 Overflow between attendants (mutual aid)
The overflow between attendants function allows other attendants to handle calls when there are too
many on one console.

The 4059 console allows you to enable this function and to choose how many calls there must be on a
console before overflow to the other attendants takes place.

In the Extension menu, select Service mode (or press the F10 key). Select Traffic.

5.11.1 Enabling overflow between attendants
In the Traffic option, select Traffic state.

1. Select Enable to implement overflow between attendants.

Select Disable to stop overflow to other attendants.
2. Click on Apply.
3. Click on Close to close the window.

5.11.2 Defining the overflow threshold
In the Traffic option, select Traffic threshold.
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1. In the Overflow threshold field, enter the number of calls there must be on a console before overflow
to other attendants takes place.

2. Click on Apply.
3. Click on Close to close the window.

5.12 Managing users
Double-clicking on this function opens the following window:

1. Select the search type.
2. Enter the information to search for.
3. Click on Search.

A list of users displays.
4. Select a user.
5. Click on Select....
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The name and the number of the user appear at the top right.
6. Click on one of the tabs to access the corresponding service.

The modifications made to each service take effect once the attendant selects a new service or
clicks on Apply.

• Info: displays information on the user, their cost center, operating class of service (category),
metering (charging) parameters, etc.

• DND: enables the Do Not Disturb function on the user's set.
• Passwd: resets the password on the user's set.
• Forward: used to program certain forwards on the user's set:

• no forwarding
• unconditional forwarding
• forwarding on busy
• forwarding on no answer
• forwarding on busy and no answer

Note:
The main line forwarding and secondary line forwarding functions are only available for multiline sets.

Enter the number of the set to which calls are to be forwarded.

To delete a forward, choose No forwarding in the list or press Reset.

Click on Apply to store the changes.

Click on Close to close the window.

5.13 Metering (charging)
Configuration of the tracking of costs is the system administrator's responsibility. On the 4059 console,
the metering (charging) function is used to configure the charge counters for the users, send a financial
report, and monitor user calls.

In the Extension menu, select Service mode (or press the F10 key). Select Charging.
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Note:
When the call has been transmitted via a QSIG network, the application can only display the number of charging
units, not the actual call cost.

5.13.1 Counter
The counter is used to obtain call costs per set and per system node. Since this information is of a
sensitive nature, it is advisable for the system administrator to limit access to it using a password.

Double-click on Counter:

1. Select the search type (by name or by number).
2. Enter the information to search for (user name or number).
3. Click on Search.

A list of users displays.
4. Select a user.
5. Click on Select....
6. Once the information is obtained, click on:

• Reset to reset the counters.
• Search to return to the previous screen and carry out a new search.

5.13.2 Financial report
The financial report is used to search for and classify user metering (charging) data. Since this
information is of a sensitive nature, it is advisable for the system administrator to limit access to it using
a password.

Double-click on Financial report.

In the relevant fields, enter the start and end dates of the report to be created.

Click on Print to print the report.

5.13.3 Monitoring users
This function is used to create filters to monitor costs generated by certain sets. Monitoring can be
carried out by user or by groups of users. Certain specific calls (exceeding a duration x or a cost y) can
also be monitored.
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5.13.3.1 Monitoring options

Double-click on Monitoring options.

To put a filter in place, select:

• No user: no internal set is monitored.
• All users: all users are monitored.
• Users in list: users in the list defined by the attendant are monitored.

Then select:

• By duration: to monitor calls according to their duration.
• By cost: to monitor calls according to their cost.
• By cost and duration: to monitor calls according to their cost and duration.
• All calls: to monitor all calls.

Confirm your choices by pressing the Apply button.

5.13.3.2 Tax threshold

This function is only available if the filter defined in Monitoring options on page 64 is By cost or By
cost and duration.

1. Enter the minimum value of the cost to take into account in the reports.
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2. Click on Apply.

5.13.3.3 Duration threshold

This function is only available if the filter defined in Monitoring options on page 64 is By duration or By
cost and duration.

1. Enter the minimum value of the duration of calls to take into account in the metering (charging)
reports.

2. Click on Apply.

5.14 Decommissioning a defective external line
In the Extension menu, select Service mode (or press the F10 key). Select Out of service trunk(s).

The list of out of service trunks displays.

The same window can be accessed via a programmable key, as long as the system administrator has
programmed it.
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5.15 Date - Time
In the Extension menu, select Service mode (or press the F10 key). Select System.

1. Modify the date and time used by the Alcatel-Lucent OmniPCX.
2. Click on Apply.
3. Click on Close to close the window.

5.16 Configuring DECT/PWT mobile (cell) phones
This function is used to display and configure the users of DECT/PWT mobile (cell) phones on the
system. This function is obsolete.
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